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Mari jelajahi dunia ICT yang menarik bersama Institute for Advanced and
Smart Digital Opportunities (IASDO) dan Pusat Pengajian
Pengkomputeran UUM! Dapatkan modul yang menyeronokkan dan
informatif yang akan membantu anda memahami teknologi masa depan
dengan lebih mudah. Dengarkan konsep yang mudah difahami, lihat
visual yang menarik, dan pelajari contoh-contoh dunia nyata yang
memperlihatkan kemungkinan tanpa had dalam ICT. Jangan lepaskan
peluang untuk mengenali teknologi masa depan!

PRAKATA
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PRESENTER: IDAH PINDAI ZENGENI

Introduction to ICT
Information Communication Technology



What is ICT ?
ICT stands for Information and Communication Technology

By definition, it stands for a diverse 
set of technological tools and 
resources used to transmit, store, 
create, share or exchange 
information.



Yael Amari | VA Presentation 202003

Technological tools and 
resources include:

Computers Internet Television Cellphone

Others items such as Satellites , websites, applications and etc 



Information - Data that is organized, 
meaningful and useful.

Communication - Process of sharing 
data, programs and information .



Computers
Computers are an important component in ICT.

Definition: electronic device that can input, output, store and process information, otherwise known as 

'data' Types of computers

Desktop laptop Smartphones

Wearable
Smart TvsTablet computers



Components of ICT 
Hardware

Physical components 

that make a computer 

system.

Software

Programs  that control 

computer system.

User

The people who use Ict  

tools.

Data

Raw facts and figures

Network

Enables devices to 

communicate and share 

information



Hardware
Categories  of hardware

• Internal 2. External



Software
Categories  of Software

• Applications software - Provide 

services that users can use to do a 

task

2. System Software - Provides a 

platform on which all other software 

can run on. 

Windows Operating system software
Games

powerpointword 



Applications of ICT
• Communication - Email, whatsapp

• Education - Virtual classroom

• Healthcare - Computer to monitor patients

• Entertainment - Streaming video like Youtube



Emerging technologies in ICT
Artificial Intelligence(AI)

AI: is usually  a machine or application that carries tasks that require intelligence.

Extended Reality 

Refers to combination  of real and virtual 

environment.e.g Virtual Reality



Word and Excel 
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What is Microsoft Word and its uses?

What is Excel and its uses? 

Microsoft word is a word processor software. I t is used to create 

professional quality documents,letters, reports and etc.  

Excel is a spreadsheet program which enables: 

• users to format

• organize

• calculate date



Word Interface
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Document 

Creation
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We can create a blank document that 

we can customize to our liking  

Or  to save time we can search and 

choose a template  to our liking



Text Formatting

Page layout - make adjustments to the pages.

Document Formatting

• Change font.

• Change the font size.

• Change Font colour.

• Bold, Italics and Underline.

• Alignment.

• Line spacing.



Adding  Tables 

1. Go to the Insert tab

2. Select Insert table 

3. Decide the number of rows and columns.

4. Decide on the rows and columns, table behaviour and select 



Save a new document
• Click the Save button

2. Select where to save the document

3. Select the save type

4. Select 'Save'



Interface

Microsoft Excel



Entry
Select a cell in the worksheet and enter the information 



Calculations using AutoSum - Quick calculations

The AutoSum allows for quick calculations such as:

● Sum

● Average

● Count numbers

● Find the Max and Min number

1. Select the range you want to calculate with.

2. Select AutoSum from the FORMULAS tab.

3. Select the Calculations to do.



Charts and graph

1. Select a the range of information you want to 

use for your chart 

2. Go to Insert tab and  Click the dialog launcher or recommended 

charts

3. Select the chart you want and press ok.



Design Charts
Select your chart.

on the Design tab you can :

• Change layout

• Change color 

• Change chart styles



Powerpoin
t





Creating a new presentation 

When creating a new 
presentation we are 

usually greeted by this 
interface

You have three options:

• Blank

• Template

• Theme



Themes
Themes are predefined combination of :

• Colors

• Fonts

• Backgrounds

• Margins

• Etc



• Templates are similar to 
Themes but they are 
more!

• Templates will contain 
their own Content 
Placeholders to fit the 
purpose of the 
presentation.

• Meaning they will have 
more graphs and 
defines the type of 
visual each slide has.

Templates



Slides

Inserting a new slide Change slide type



Add content

Images

Video



• Online and Offline

• Set image as background

Images



You can Add a video to your you presentation
You can further customize the video on the video tools tab:

• Format

\

• playback

Video



Tips
• List the core points only.
• Consistent with the 

style
• Do not to many words.
• Use Templates



INTRODUCTION TO 

CANVA



WHAT IS CANAVA

• User-friendly online graphic design platform.

• Used to create posters, presentations, magazines and more.

• Canva offers a variety of elements, design tools and 

templates.

• Range of features including drag-and-drop functionality, a 

diverse library of images and fonts, and the ability to 

collaborate and share designs with others.

Overall Canva allows us 

to create appealing 

designs without 

advanced skills



THE INTERFACE

The first webpage when you login into your account. Here is where you can create your 

designs in multiple ways:

• Create blank design

• Select type of design and choose a template



DESIGN TAB Here is were we can choose readily made templates, layouts 

and styles that can be applied to one page or the whole 

project.



Elements are items that can are used to decorate. 

There are categorized mainly by  Lines, Shapes, 

Frames, Stickers, Charts, Grids, and Gradients They can 

be static or animated. 

• Simply search for an element

• Choose the category 

• Click on the element.

• Adjust as needed.

ELEMENTS

Menu above will allow for the elements to be edited. 

The menu changes according to the element selected.



ANIMATE

Animate is a feature that allows you to control how your content will appear when you visit the page or exit it.

This works for :

• Page

• Text

• Elements

• Images

• Background



TEXT
To insert Text into your page you simply head to the 

Text page.

Here you have the following options to choose :

1.Add empty textbox

2.Default text styles

3.Font Combinations - readily made text with styles 

and colors already set .

You can use the search bar to look for 

Fonts.

Menu above is used to customize the Font.



UPLOAD MEDIA

To upload media you can simply click

"Upload files".

or just drag and drop any media file

(Images, Videos and audio only).



APPS
Apps are an option for you to add other features. Example 

inserting a customizable QR code!



CHARTS Charts are great for showcasing data in a appealing form!

First you choose the desired chart.

Then insert the data. The chart will adjust itself based on the data 

entered



FILMORA



WHAT IS FILMORA AND WHY 
• Its lightweight.

• User Intuitive

• Free!



GETTING STARTED

Download filmora. 

https://filmora.wondershare.com/video-

editor/video-editor-download.html

Install Filmora and its ready for use.



FILMORA INTERFACE

These are tracks, in the beginning, 

you have two. 



MEDIA 
To add the media you will be using for your video project.

You can add many media files such as videos, audio 

and pictures from your computer.

You can also add new media and download from 

filmora.



EDITING

Add content
Split and Trim

Drag the red line.

Click the scissors and the video will 

split.



AUDIO EDITING
To edit the audio, you simply need to click Audio on the 

side menu. In this section, you have a variety of options 

to manipulate the audio.

To mute or unmute the video audio. Simply need to click 

and unclick the audio logo.



TRANSITIONS

• Prefix - The transition will happen before it moves to 

the next clip.

• Overlap - The transition will happen between the 

current and next clip.

• Postfix - The transition will happen after the next clip.

The shift from one clip to another clip



Effects 
Adding special effects to your video is 

simple !

You simply need to go to Effects.

• Video Effects

• Audio Effects 

Some of the effects will need to be 

downloaded first.

Once you are done  downloading the 

effects you can now add the effect in two 

methods !



Effects 
The first method is by overlaying on 

another track. 

With this method, you can control where 

the effect starts and where it ends.

The second method is by dragging the effect 

over the video. this method will affect the whole 

video.  

The effect is on a new track and will only affect 

the length that it is set at with the other track. 

The length of how long the effect will take 

place and where can be adjusted like this



Exporting the video
Click Export and select where you want 

to export the video. To save to your 

computer select Device.

Configure the video's details such as 

name, quality and which folder to keep 

the video. Simply click export after that.



Introduction to ICT 

1. What does ICT stand for? 

a) International Communication Technology 

b) Information and Computer Technology 

c) Integrated Circuit Technology 

d) Information and Communication Technology  

 

2. What is the difference between Hardware and 

Software? 

a) Hardware refers to physical components, while 

software refers to virtual components. 

b) Hardware is the brain, while software is the body. 

c) Hardware is tangible, while software is 

intangible. 

d) Hardware represents the physical devices, while 

software represents the programs that control 

computer system. 

 

 

 

 

 

3. Which of the following is a type of computer that 

you can carry around like a small book? 

a) Desktop 

b) Television 

c) Laptop  

d) Refrigerator 

 

4. What are the types of Computers? 

a) Desktop, Laptop, Mainframe, Calculator 

b) Tablet, Server, Digital Camera, Smart TV 

c) Smartphone, Game Console, Microwave Oven, 

E-reader 

d) Desktop, Laptop, Smartphone, Tablet, Wearable, 

Smart TVs  

 

5. Which of the following is not a Component in 

ICT 

a) Hardware 

b) Software 

c) Data 

d) Telepathy  

  

 



Introduction to Word and Excel 

1. What is Microsoft Word primarily used for? 

a) Creating and editing spreadsheets 

b) Designing and editing presentations 

c) Writing and formatting documents  

d) Managing and analyzing data 

  

2. What is the purpose of a chart in Excel? 

a) To organize and sort data 

b) To create visually appealing and informative 

representations of data  

c) To apply formatting and styling to a worksheet 

d) To perform calculations and analyze data 

  

3. Which of the following is a common use of 

Microsoft Word? 

a) Sending emails 

b) Playing video games 

c) Writing letters and documents  

d) Drawing pictures 

  

 

 

 

 

4. Line spacing is ? 

a) The space between each letter of a word 

b) The space between each line of a paragraph  

c) Both of the above 

d) None of the above 

  

5.MS Excel is a ________. 

 A. Database Management software 

B. Presentation software 

C. Workbook software 

D. Spreadsheet software  

 

 

 

 

 

 

 

 

 

 

 

 

 



Introduction to PowerPoint  

1. What is the purpose of PowerPoint? 

a) To create and edit spreadsheets. 

b) To design and print documents. 

c) To create and deliver multimedia presentations.  

d) To browse the internet and send emails. 

 

2. How can you insert a video into a PowerPoint 

presentation? 

a) By copying and pasting the video file directly 

onto a slide 

b) By recording a video using the built-in camera 

feature in PowerPoint 

c) By using the "Insert" tab and selecting the 

"Video" option  

d) By converting the video into a series of images 

and inserting them one by one 

  

 

 

 

 

 

 

3. Which of the following is advisable when making 

your slides for presentation? 

a) Use a small font size to fit more content on each 

slide. 

b) Use a variety of bright and contrasting colors for 

text and backgrounds. 

c) Limit the amount of text on each slide and use 

visuals to enhance understanding.  

d) Include long paragraphs of information for 

thoroughness 

 

4. What is a slide in PowerPoint? 

a) A digital drawing tool 

b) A unit of measurement 

c) A single page or screen in a presentation  

d) A type of animation effect 

 

5. Which of the following is a feature of 

PowerPoint? 

a) Creating and editing videos 

b) Creating and editing websites 

c) Creating and editing slide-based presentations  

d) Creating and editing music playlists 

  

  

 



Introduction to Canva 

1. What is Canva ? 

a) A popular social media platform 

b) A graphic design platform  

c) A video streaming service 

d) A mobile game development company 

  

2. What type of content can be created on Canva 

? 

a) Presentations, social media graphics, posters, and 

more  

b) Spreadsheets, documents, and databases 

c) Video editing and animation 

d) Gaming applications and virtual reality 

simulations 

  

      3.  How can Canva be helpful for school projects? 

a) By making paper airplanes 

b) By providing book recommendations 

c) By creating visually appealing presentations and 

posters  

d) By organizing a school dance 

  

 

 

 

4. These are the advantages of Canva except... ? 

a) It has multiple templates for everyone to design 

b) It can be shared to various social media 

c) It is free 

d) Users need to have basic knowledge of Graphic 

Design.  

  

5. What is the purpose of templates in Canva? 

a) To provide pre-designed layouts that users can 

customize for their own projects. 

b) To add sound effects to designs 

c) To generate automatic color schemes 

d) To create animated graphics and videos 

 

 

 

 

 

 

 

 

 

 

 

 

 



Introduction to Filmora 

 

1. What is Filmora ? 

a) A video editing software  

b) A music streaming platform 

c) A photography editing tool 

d) A social media network 

 

2. What is the purpose of adding transitions 

between video clips in Filmora? 

a) a) To make the video file larger  

b) b) To create smooth and visually appealing scene 

changes  

c) c) To add text to the video  

d) d) To remove all audio from the video 

  

3. True or False: Filmora is a software used for 

editing photos only. 

a) True 

b) False  

 

 

 

 

 

4. The scissors feature allows you to trim footage to 

the desired length. 

a) True  

b) False 

 

5. All Which of the following elements can you 

include in a Filmora project to make your video 

more engaging?  

a) Stamps and coins  

b) Video clips, music, and text  

c)  video game 

d) Slides 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



ANSWERS  

 

MODULE 1 : 

 

1. D 

2. D 

3. C 

4. D 

5. D 

 

MODULE 2 : 

 

1. C 

2. B 

3. C 

4. B 

5. D 

 

MODULE 3 : 

 

1. C 

2. C 

3. C 

4. C 

5. C 

 

 

 

 

 

 

 

MODULE 4 : 

 

1. B 

2. B 

3. C 

4. D 

5. A 

 

MODULE 5 : 

 

1. A 

2. B 

3. B 

4. A 

5. B 

 


